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Home Page

@ One World, One Internet Back to ICANN Account SEARCH Q VictoriaYang @ Logout v fin
ICANN

HOME DATA CHARTS API ABOUT HELP

Welcome to ICANN Open Data :
Platform! .Y

The goal of ICANN's Open Data Program is to provide the ICANN O P EN DATA
community with access to publicly available data. You can search,

browse, view, download, and analyze the available data. Please
visit the About page to learn more.

[ — T _—=
Register to access available data and site features |
— |

By registering, your account will allow you to:

% Access and use all data available on this platform for free

% Search, browse, view, download, and analyze the data, according to the
platform’s terms and conditions and the license(s) applied to each datasets

% Save customized analyses

* Choose to receive notifications when selected datasets are updated

% Generate API keys and view API quota usage




Home Page

Share

Indicators

Browse ICANN Datasets

Domain Name Identifier Registry Functions Per-Registrar
Marketplace Technology Health Activity Reports Transactions

Indicators (ITHI) Reports

1 9 dataset(s) | dataset(s) 1 dataset(s) 11 dataset(s)

Share the ICANN Open Data Platform
home page

«* There are 32 datasets in Launch V1.
+» Users can browse related datasets via these 4
tiles
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Home Page

List of latest 5 datasets
with either the data or

metadata updated

List of top 5 datasets

with the most
downloads

List of top 5 datasets

with the most API calls

Latest Updates

Number of involuntary gTLD
registrar terminations
Modified a day ago

Number of involuntary gTLD
registry terminations
Modified 4 days ago

Total number of gTLD registry
operator and gTLD registrar
related complaints

Modified 8 days ago

Number of domains by ICANN
region in gTLDs and ccTLDs
Modified 9 days ago

Number of distinct gTLD
registrar entities (Total and
New)

Modified 9 days ago

i
Most Downloaded

ITHI: DNS Root Traffic Analysis

8 downloads

Per-Registrar Transactions
Report 2009

3 downloads

Number of gTLD registrars
accredited and terminated
(Total and New)

2 downloads

Number of domains by ICANN
region in gTLDs and ccTLDs
2 downloads

Total number of gTLD registry
operator and gTLD registrar
related complaints

2 downloads

Most API Calls

ITHI: DNS Root Traffic Analysis
1225 API calls

Per-Registrar Transactions
Report 2009
724 API calls

Number of domains by ICANN
region in gTLDs and ccTLDs
548 API calls

Number of domains (by TLD

category)
467 API calls

Total number of gTLD registry
operator and gTLD registrar
related complaints

368 API calls

@

TCANN Note: Metrics shown on this screen shot is for demonstration purpose only.



Home Page

+* Check out other ICANN sites
+» Connect with us via ICANN Social Media Platforms

s Check out Career Opportunities at ICANN

OTHER ICANN SITES CONNECT 'NVITH US
. You
il
ICANN.org Generic Names Supporting Organization (GNSO) , in F D m
Address Supporting Organization (ASO) Governmental Advisory Committee (GAC)

CONTACT US
At-Large Root Server System Advisory Committee (RSSAC)

CAREEF 5 AT ICANN
ICANN Community Wiki Security and Stability Advisory Committee (SSAC)

Country Code Names Supporting Organization (ccNSO)

© 2020 Internet Corporation for Assigned Names and Numbers Privacy Policy Cookies Policy Terms of Service

Review our Privacy Policy, We are committed to continually
Cookies Policy and Terms of improving this platform. We
Service before using the Open welcome your feedback, please
Data Platform. contact us.




Data Page

Number of

datasets available |

Sort the datasets
with multiple

options here

Use filters to help
find the datasets

Click on the

dataset to explore
more

Download catalog
allows users to

download the
entire data page
along with the
datasets metadata
12

ICANN

Marketplace Stability

I HOME DATA CHARTS API
32 datasets Compound annual E8 Table
growth rate (CAGR) of
Sort datasets Alphabeticall . Il Analyze
’ 4 number of domains (by M
Modified  Popular =~ AZ i
TLD category) O B
Publisher ICANN Org API
Fllters License Open Database License bg
- (0DbL)
Find a dataset... Q
Domain Name Marketplace
Modified Indicators
2020 32
Mean number of gTLD B Table
registrars per distinct
N " Anal
L LR gTLD registrar entity Ll Analyze
Domain Name Marketplace 19 ) & Export
Indicators Publisher ICANN Org
License Open Database License
BamintamihantlRana P (0DbL) L} API
Robust Competition 12
Registrar 1 .
Domain Name Marketplace
Transacions " Indicators
Marketplace Stability 4
> More
Mean registration period g5 Table
for domains (by gTLD
Download catalog P
il Analy.
category)
. . . i 3. Export
This catalog is available as: publisher  ICANN Org % Expol
ECsv & License Open Database License
(ODbL) L5 APIL
I RDF (Turtle) &
Domain Name Marketplace
& RDF (XML) & Indicators
I RSS feed &

ABOUT

ITHI: DNS Root Traffic
Analysis

Publisher ICANN Org

License Open Database License
(ODbL)

‘ ITHI DNS Root Traffic

Mean number of gTLD
registries per distinct

gTLD registry operator

entity

Publisher ICANN Org

License Open Database License
(ODbL)

Robust Competition

Domain Name Marketplace

Indicators

Net change in number of
domains (by TLD
category)

Publisher
License

ICANN Org
Open Database License
(ODbL)

Robust Competition

Domain Name Marketplace

Indicators

HELP

BB Table
|shl Analyze

& Export

L AP

B Table

|shl Analyze
& Export

L AP

BB Table

[shil Analyze
& Export

4 APIL




Dataset Page

Select the Information tab to find basic
iInformation about the selected dataset

12 records Total number of gTLD registry operator EHEE
and gTLD registrar related complaints

No active filters

© Information &8 Table lul Analyze & Export £ API

Filters
The Domain Name Marketplace Indicators present statistics pertaining to the marketplace for generic top-

level domains (gTLDs) and country code top-level domains (ccTLDs).

Search records... Q
ICANN org collaborated with a community Advisory Panel on this effort. The version 1.0 indicator

schema outlines the indicator categories, dimensions / factors, metrics, and includes a glossary of terminology.
Dimension The specific calculations performed to arrive upon the indicator values are available in the version 1.0 indicator

taxonomy document.
gTLDs 12

Total number of gTLD registry operator and gTLD registrar related complaints shows how registrants
view contract fulfillment by registrars and registries. Tied to registrant decisions to file complaints after

Segment registry/registrar interaction. Value varies as registrars and registries deliver on obligations.
Registrar-related Complaints 6 Note:
Received 1. ICANN Contractual Compliance Quarterly Reports, Compliance Approach & Process, Available at
) ) https://features.icann.org/compliance/dashboard/report-list
Registry-related Complaints 6
Received 2. The values reported here are as of 30th June (H1) and 31st December (H2) for each calendar year.

@
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Dataset Page

Select the Table tab to view the data
as table

o
S Total number of gTLD registry operator EIEHEIE
. .
—— and gTLD registrar related complaints
O Information 8 Table Ll Analyze & Export £ API
Filters
\gory Indicator Dimension Segment Period Value C Notes
<etplace Stability MS_1.1 gTLDs Registrar-related Complaints Rec 2018 H1 17,015
Search records... Q <etplace Stability MS_1.1 gTLDs Registry-related Complaints Rece 2017 H2 597
<etplace Stability MS_1.1 gTLDs Registry-related Complaints Rece 2018 H2 443
Dimension <etplace Stability MS_1.1 gTLDs Registrar-related Complaints Rec 2017 H2 24,360
<etplace Stability MS_1.1 gTLDs Registrar-related Complaints Rec 2018 H2 17,957
gTLDs 12 <etplace Stability MS_1.1 gTLDs Registrar-related Complaints Rec 2019 H1 11,845
<etplace Stability MS_1.1 gTLDs Registry-related Complaints Rece 2017 H1 882
<etplace Stability MS_1.1 gTLDs Registry-related Complaints Rece 2018 H1 543
<etplace Stability MS_1.1 gTLDs Registry-related Complaints Rece 2019 H1 1,390
. . <etplace Stability MS_1.1 gTLDs Registrar-related Complaints Rec 2016 Total 43,156
Registrar-related Complaints 6 N ) )
Received <etplace Stability MS_1.1 gTLDs Registrar-related Complaints Rec 2017 H1 24,650
<etplace Stability MS_1.1 gTLDs Registry-related Complaints Rece 2016 Total 2,230
Registry-related Complaints 6
Received
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Other Examples

@

ICANN

| 985,358 records

No active filters

I

Search records... Q
EN
com 28,538
net 28,258
org 20,269
info 4,744
biz 3,832
Xyz 3,377
> More
Ca—
12 85,310
1 85,129
10 84,531
09 83,936
08 83,500
07 83,056

Per-Registrar Transactions Report 2018 HEEE

@ Information

TLD

miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami
miami

miami

Share

https://opendata.icann.org/explore/embed/dataset/per-registrar-transactions-report-2018/tak

[l Analyze & Export

&8 Table
C  Year  Month
2018 02
2018 02
2018 02
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10
2018 10

A Embed Widget

registrar-name

porkbun_mm

Hosting Ukraine LLC

Domain Research, LLC
Register.com, Inc.

COREhub, S.R.L.

Tucows Domains Inc.

1&1 Internet SE

Whois Networks Co., Ltd.

Ascio Technologies, Inc. Danmarl}
Secura GmbH

GoDaddy.com, LLC

PSI-USA, Inc. dba Domain Robot
CSC Corporate Domains, Inc.
Sea Wasp, LLC

DomainName, Inc.

EnCirca, Inc.

DomainSite, Inc.

Nom-iq Ltd. dba COM LAUDE
Epik, Inc.

Name.com, Inc.

IP Mirror Pte Ltd dba IP MIRROR
Net 4 India Limited

£ API

iana-id &
1,861
2,374
2,484
9

15
69

83
100
106
m
146
151
299
41
450
455
466
470
617
625
890
1,007

total-domains &
44

0

0

14

0

147
215

7

24

0
6,174

total-r
23
0

0
28
0
97
284
4
35
0
533
20
49

L)

Use the filter option on the left to refine your search. For example, the Per-
Registrar Transactions Report 2018 has approximately 1 million records,
users can filter the data table by TLD or month. (see next slide).
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ther Examples

4744 records Per-Registrar Transactions Report 2018 EHEE

Active filters @ Clear all @ Information B Table Ll Analyze & Export 5 API
info TLD & Year  Month registrar-name iana-id ¢ total-domains U  total-name
105 info 2018 01 101domain GRS Ltd 1,011 2,874 70
1051 info 2018 01 10Dencehispahard SL 1,403 1,880 58
. 1052 info 2018 01 AB Name ISP 1,371 1,451 19
Filters L .
1 info 2018 01 Abraham Lincoln, LLC 2,289 1" 0
105 info 2018 01 Achilles 888, LLC 2,290 1 0
Search records... Q 1 info 2018 01 Address Creation, LLC 270 20 0
1056 info 2018 01 Adomainofyourown.com LLC 1,158 323 4
1057 info 2018 01 Alantron Bilisim Ltd Sti. 898 70 2
nb 1058 info 2018 01 Alexander the Great, LLC 1,702 10 0
com 28,538 info 2018 01 Alice's Registry, Inc. 275 197 2
10 info 2018 01 Allearthdomains.com LLC 1,159 309 2
net 28,258 1061 info 2018 01 Alpnames Limited 1,857 489 95
1062 info 2018 01 Arcanes Technologies 3,245 43 2
°org 20.269 info 2018 01 Arctic Names, Inc. 1,340 154 0
info 4,744 1 info 2018 01 Ares 888, LLC 2,293 6 0
info 2018 01 Ascio Technologies, Inc. Danmart 106 55,110 277
biz 3,832 1066 info 2018 01 Astutium Limited 1,471 126 0
Xyz 3377 info 2018 01 Atak Domain Hosting Internet ve 1,601 92 12
1068 info 2018 01 AtlanticFriendNames.com LLC 1,157 325 2
> More 1 info 2018 01 Azdomainz LLC 1,391 4 0
10 info 2018 01 BB Online UK Limited 134 257 8
Month 1071 info 2018 01 Belmontdomains.com LLC 1.163 303 6
01 409 Share A Embed
02 409 https://opendata.icann.org/explore/embed/dataset/per-registrar-transactions-report-2018/tat Iy
03 409

This is the view of the Per-Registrar Transactions
Report 2018 by the TLD .info.

@

ICANN
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Dataset Page

@

ICANN

Select the Analyze tab to view the data as chart

12 records

No active filters

Filters

Search records... Q

gTLDs 12

Registrar-related Complaints 6
Received
Registry-related Complaints 6
Received

2016 Total 2
2017 H1 2
2017 H2 2
2018 H1 2

Total number of gTLD registry operator EHEE
and gTLD registrar related complaints

O Information &8 Table & Export of API

X axis Period : Max. number of points  Show all
Break down series Segment : Stack No stack % + Add a series
| Columnchart % ”I" Yaxis Sum + Value §
50k
40k
Y 30k
=
>
E
A 20k
10k
0 | — —_— —_— - —
g 3\ R \x\ 3\ N
o ~ -~ NG N ~
> v v v Vv Vv
Period

Registrar-related Complaints Received @ Registry-related Complaints Received

Edit in advanced mode

Please visit the Help page for more information and other available

resources.
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Other Examples

. o - .
Number of domains (by TLD category) EIRIEIE]| | Number of domains (by TLD category) HEHEER
© Information &8 Table Ll Analyze & Export % API @ Information &8 Table [l Analyze & Export o API
X axis  Period v Max. number of points  Show all % Xaxis  Period + Max. number of points  Show all §
Break down series Segment s Stack Normal % <+ Add a series Break down series Segment ] Stack Normal % <+ Add a series
Areaspline % . Yaxis Sum + Value § Area spline . Yaxis Sum + \Value
6M 250M
200M
am
E: 35 150m
s s
£ E
3 3 100M
2™
50M
0 0
x\t‘ﬂ x\t\\ a\"\'\\ 3\"\'\\ ‘\F\ & > 3 \\‘9\
Period
IDN ccTLDs Legacy gTLDs
@ IDN gTLDs @ New gTLDs

Users can select / unselect the legend element to customize the chart

113



Dataset Page

Select the Export tab to export the dataset in
your preferred format

O Information &8 Table Ll Analyze

Total number of gTLD registry operator EEEE
and gTLD registrar related complaints

& Export

5 API

dataset's license (Open Database License (ODbL)).

In order to download this dataset, you need to accept the portal's terms and conditions and the

v I accept the portal's terms and conditions and the license applicable to the dataset.

HOME

12 records

No active filters

Filters

Search records...

gTLDs

@

ICANN

DATA

CHARTS API ABOUT

Total number of gTLD registry operator
and gTLD registrar related complaints

© Information &8 Table [l Analyze % API

This dataset is licensed under : Open Database License (ODbL)

Flat file formats

csv & Whole dataset

CSV uses semicolon (;) as a separator.

JSON & Whole dataset

HELP

v ] fin]=]
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Dataset Page From any tab, you can share a link to a
dataset on social media or by email

B Total number of gTLD registry operator C 1K EY =D
and gTLD registrar related complaints

Active ﬁlters @ Clear all O Information BB Table Ll Analyze & Export «f API

Registry-related

Complaints Received

Filters | Column chart % Il vaxis sum
Search records... Q

Dimension

)

1500

gTLDs

Segment

St

)

Registry-related Complaints
Received

o
& & &
< Q Q RS
&2 " o W
Period |
Registry-related Complaints Received

2016 Total
2017 H1
2017 H2 Share A Embed Widget

2018 H1

ttps://opendata.icann.org/explore/embed/dataset/total-number-of-gtld-registry-operator-ani = Iy
2018 H2

You also can share the dataset via embed or widget features,
where applicable:

s Share: Selection will allow you to copy and paste a shareable URL
% Embed: Selection will generate the iframe code of the visualization.
% Widget: Selection will generate the widget code of the visualization.

@
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Other Pages:

® Charts page

o With the Chart builder tool, you can visualize
multiple datasets on a single customized chart.

o Compare to the Analyze tab on a dataset page, this

page will give your more options, such as combining
different datasets.

® API page
o The API (Application Programming Interface) is an
interface for programs to communicate and
exchange data.

® Please visit the About page and Help page for more
information and available resources.
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.ICANN Open Data Platform Launch at ICANNG67

s/1152530
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https://67.schedule.icann.org/meetings/1152530

Thank You Very Much

3’@ One World, One Internet

ICANN

Visit us at icann.org

@icann
facebook.com/icannorg
youtube.com/icannnews
flickr.com/icann
linkedin/company/icann
slideshare/icannpresentations

soundcloud/icann

0660000




